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1 Mic-In / 1 Instrument-In, 2 Out professional recording USB 
interface.



Important Safety Instructions

1. Read this manual thoroughly before using this unit.

2. Keep this manual for future reference.

3. Take notice of and comply with all warnings included in the user's manual or indicated on the   
 appliance.

4. Follow all instructions included in this manual.

5. Do not expose this unit to rain or moisture. Avoid having water or other liquids spilled on this   
 unit.

6. When cleaning the cabinet or other parts of this appliance, use only a dry or slightly damp soft   
 cloth.

7. Do not block any ventilation openings or interfere with the proper ventilation of this unit. Install  
 in accordance with the manufacturer's instructions.

8. Do not use or store near any heat sources such as radiators, heat registers, stoves, or other heat- 
 producing appliances.

9. To avoid the risk of electrical shock, do not touch any exposed wiring while the unit is in   
 operation.

10. Only use attachments/accessories specified by the manufacturer.

11. Unplug this unit and all connected electrical equipment during lightning storms or when left   
 unused a long period of time.

12. Refer all servicing to qualified service personnel. Servicing is required when the appliance has   
 been damaged in any way or fails to operate normally.

WARNING: To reduce the risk of fire or electric shock, do not expose this unit to rain or moisture
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Introduction

What’s in the package?
 ● USolo USB Recording Interface
 ● Quick Start Guide x 1
 ● USB 2.0 cable (Type C) x 1

Firstly, congratulations on your purchase of the ICON Pro Audio USolo digital 
audio Interface! In these pages, you'll find a detailed description of the features 
of the USolo digital audio Interface, as well as a guided tour through its front, top 
and rear panels, step-by-step instructions for their setup and use and a full list of 
specifications. 

As with most electronic devices, we strongly recommend you retain the original 
packaging. In the unlikely event that the product is returned for servicing, the original 
packaging (or reasonable equivalent) is required. With proper care and adequate air 
circulation, your USolo digital audio interfacewill operate flawlessly for many years to 
come.

We trust that this product will provide years of excellent service and in the unlikely 
event that your product does not perform to the highest standard, every effort will be 
made to address the issue.
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Register your ICON ProAudio product to your 
personal account  

1. Check serial number of your device
 � Please go to  http:// iconproaudio.com/registration or scan the QR code  

below.
 �  

 � Input your device’s serial number and the other information on the screen. Click 
“Submit”.

 �
 � A message will pop up showing your device information such as model name 

and its serial number - Click “Register this device to my account” or if you see 
any other message, please contact our after-sales service team

 �

2. Log in to your personal account page for existing users or 
sign up as for new user

 � Existing users: Please log into your personal user page by inputting your  
   user name and password.

 �
 � New users:  Please click “Sign Up” and fill in all the information.
 �

3. Download all useful materials
 � All your registered devices under your account will show on the page. Each 

product will be listed along with all its available files such as drivers, firmware, 
user manuals in different languages and bundled software etc. for download. 
Please make sure you have downloaded the necessary files such as the driver 
before you begin device installation.
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Features

The main features include:
 ● 24-Bit 192KHz 1 mic-In, 2-Out USB Recording Interface
 ● Supports Mac/PC or iOS/Android connectivity operation
 ● Live sessions possible with audio signal processing via ProDriver4 virtual plug-in 

rack
 ● 2×2 analog I/O full duplex recording and playback
 ● For direct connection with smartphone, tablet or other device
 ● Mic/Instrument preamps with individual gain control and phantom power switch
 ● 2 analog outputs on 1/4” TRS jacks
 ● 1 headphone output with assignable source and individual volume control
 ● Flexible channel routing via the ProDriver4 software control panel
 ● ICON Pro Audio developed ultra low latency ProDriver4™driver
 ● ICON Pro Audio innovative and user-friendly plug-in hosting rack software with 

ProDriver4™ (Windows and Mac)
 ● USB 2.0 High Speed and USB bus-powered functionality
 ● Supports DirectSound, WDM and ASIO 2.0
 ● LoopBack function is equipped with ProDriver 4™ for both Mac and Windows 

platforms
 ● Compatible with mac OS (M1/ Intel Mac) 10.11 and later, iOS 9 or above, Android 

and Windows 7, 8 & 10 (32-bit/64-bit) 
 ● Full duplex, simultaneous record/playback
 ● +5VDC power supply connector is equipped for external power supply when using 

with iOS

Affordable, dependable and robust – your new USolo recording interface will provide 
rock solid performance for years to come. Suitable for the entry level recordist 
and experienced studio producer alike, the ICON Pro Audio USolo USB recording 
interface provides quality audio inputs and outputs. At the time of writing, no other 
audio interface in the price range offers such high quality audio, (24-Bit 192KHz 
sample rate). Put simply, the Icon Pro USolo offers unbeatable value for money.
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 ● Bitwig 8Track included*
 ● Dotec audio plugins included*
 ● Tracktion DAW Essentials Collection included*
 ● Kilohearts Toolbox plugins included*
 ● Harrison 32c Vocal Intensity Processor plugin included*

*Please sign up for an account on www.iconproaudio.com andregisteryourdevice. 
Your free software will be available in your user area, (click on the ‘graphic’ of the 
device)
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5321 4

Front Panel 

1. Master volume
 � The master level control will adjust the output level of the line outputs (L and R)

2. Input gain level control (Microphone)
 � This potentiometer controls the input level of the analog microphone input.

3. 3-pin XLR (Balanced) – For condenser microphones with 
+48V phantom power or dynamic microphones.

 � Please refer to P.36 for the connection method of different types of microphones 
and instruments..

4. Headphone output
 � This output jack accepts a standard 1/4″ stereo TRS headphone connector.

5. Headphone level control
 � This potentiometer controls the output level of the headphone output.
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1. Power supply connector (USB Type C)
 � The USolo is USB-bus powered. If your computer does not supply sufficient 

power, connect an ICON 5VDC power supply adapter to this jack.
 � Alternatively, you may try to use your smart phone power adapter with the 

correct cable type (USB Type C). Normally it should work and provide enough 
power to the device.

 �
 � (Note: You may purchase the power adapter from ICON distributors/dealers 

near you)
 �
 � (Note: An external power adapter is needed if the USolo is used as a standalone 

unit without a Mac or PC)

2. USB 2.0 connector (Type C)
 � Connect this port with the ‘Type C’ USB cable provided to your Mac/PC or your 

iOS device camera kit’s USB connector. Your Mac/PC must have a USB2.0 
connector in order to run the full speed of the USolo.

3. Stereo output L/R
 � This is an unbalanced analog output on a standard 3.5mm stereo connector.
 � This output jack accepts a standard 1/4″ stereo TRS headphone connector.

Rear Panel

3

1 2
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1. Mic/Inst Button
 � Press the Mic/Inst button to switch between a Mic and Instrument.

2. +48 Phantom Power
 � Press to supply +48V phantom power to the associated XLR input. This phantom 

power circuit is suitable for most condenser microphones.

1 2

Top Panel
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Mac driver installation
 � The USolo is a class compliant device. Therefore, no driver installation is needed 

for the Mac. Additionally, it fully supports iOS devices by connecting the unit to 
a camera kit.

Install Pro Driver 4 with LoopBack function
1. Download Pro Driver 4 (Mac) from your "Personal User 

Portal" page for your audio interface.
 � (Please refer to P.5 "register your ICON Pro Audio product to your personal 

account" for creating your personal user portal)

2. Double click the file "ProDriver-OSX-xxx.dmg" that you just 
downloaded from your Personal User Portal 

 �

3. Double click "ProDriver.pkg" to start the Pro Driver installation

Diagram 1

Diagram 2
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4. Click "Continue"
 �

Diagram 3

5. Click "Continue"

6. Click "Read License" to 
read the lincense terms 
or click "Agree" to start 
the installation

Diagram 4

Diagram 5

Diagram 6

7. Select the disk where 
you would like ProDriver 
to be installed and then 
click "Continue" 
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Diagram 7

Diagram 8

Diagram 9

Diagram 10

8. Click "Install" 

9. Input your password or 
tap your finger-print to 
start the installation.

 �

10. Installation will now 
start. Click "Close" after 
it has completed. 

11. At this stage, please connect 
your audio interface to your Mac 
and then click the ICON logo as 
shown. 
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12. Select your audio interface 
model from the list and 
click "Select"

USolo

13. Click"OK" to allow ProDriver 
to access the microphones. 

14. The ProDriver activated 
logo will appear on your 
desktop. Click it to launch 
the ProDriver control panel.

USolo (Core Audio) USolo: Output

USolo (Core Audio)

USolo (Bit Accurate)15. Audio MIDI setup
 � Open the “Audio MIDI setup” window 

and confirm that the USolo device 
has been set up properly as shown in 
diagram 14.

Diagram 11

Diagram 12

Diagram 13

Diagram 14
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1. HW In 1/2 level metering
 � Shows the hardware 1/2 input level. (HW In 1/2).

2. HW Out 1/2 level metering
 � Shows the hardware 1/2 output level. (HW Out 1/2).

3. LoopBack In 1-8 level metering
 � Show the LoopBack 1/2, 3/4, 5/6 & 7/8 input level.

4. LoopBack Out 1-8 level metering
 � Show the LoopBack 1/2, 3/4, 5/6 & 7/8 output level.

5. Link switch
 � Switch to adjust both channels' levels simultaneously.

6. Mute switch
 � Switch to mute the corresponding channel.

7. “0dB” switch
 � Switch to instantly adjust the corresponding channel to “0dB” level.

8. Gain control fader
 � Slide to adjust the gain level for the corresponding channel.

9. Inputs & Outputs Matrix switches
 � Switch to turn On/Off the corresponding input channel route to the corresponding 

output channel. Remember, you may route any input(s) to any output(s).

10. Mixer Presets
 � 6 Mixer-Preset button slots are available for saving or loading your routing 

channel settings.
 �
 �

Mixer control panel(Mac)
The mixers work like a matrix mixer. Activate and adjust the corresponding input or output 
channel level. They are very useful and make your inputs and outputs very flexible. You may 
route any of your input(s) to any output(s).

Usolo Live

1

3

10

9

4

5
7

2

8

6

Diagram 15
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11. Device Preferences 
 � Click "Device" at the top menu bar to launch the "Preferences" window.    
 � 11.1 Output
 � Select your audio interface as your output device
 �
 � 11.2 Input
 � Select your audio interface as your input device
 �
 � 11.3 Active output channels
 � Showing you all the available and active output channels for your audio interface 
 �
 � 11.4 Active output channels
 � Showing you all the available and active input channels for your audio interface 
 �
 � 11.5 Sample rate
 � Select your desired sample rate from the list 
 �
 � 11.6 Audio buffer size
 � Select your desired audio buffer size from the list
 �
 � (Note: If a clicking sound occurs, you should change to a larger buffer size in the 

settings. If the largest buffer size has been selected and there is still a clicking 
sound, it means your computer performance is not able to handle the task. (It is 
not caused by the USolo digital audio interface.)

1.1

1.2

1.3

1.4

1.5

1.6

USolo

USolo

Diagram 16
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Windows driver installation
Please follow the step-by-step procedures below to install your USolo USB recording 
interface and its driver.

1. Turn on your computer
 � Note: Do not connect the USolo digital audio interface to your computer yet.

2. Download the Windows driver from your User Center Page 
at www.iconproaudio.com (Please refer to P.5 "Register 
your ICON Pro Audio product to your personal account" for 
creating your personal user portal)

 � After you downloaded the driver file, please click it to start the installation 
process. 

 �

3. Installation Wizard appears
 � Choose "Next" when you see the Welcome 

Screen shown in Diagram 18.

4. License Agreement
 � Click “I Agree” to proceed.

Diagram 18

Diagram 19

USolo

V4CR4

Diagram 17
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USolo Device Drivers

r4

r4

r4

Icon_USolo_2.9.86.50.exe

r4

4

r4

5. Select components for installation
 � Check the components that you would like 

to install. We strongly recommend that you 
select all components.

6. Preparing installation files
 � Once the installation process has started,
 � the process may take some time depending
 � on your computer performance. Please be
 � patient and wait for the process to finish.

7. Click “Install” to proceed.
 � Note: The same message will appear three
 � times as there are three different driver 

installations.

Diagram 20

Diagram 21

Diagram 22

Diagram 23

Diagram 24
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8. Setup completed
 � A window as shown in Diagram 25 

should appear. Choose "Finish”.
 �

r4

r4

r4

9. Launch the software 
control panel

 � You may click the ICON ProAudio 
logo on the system tray to launch 
the software control panel (Page 20).

10. Connect your USolo 
digital audio interface

 � Now connect the USolo 
digital audio interface to your 
computer's USB port. 

1
13
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Diagram 27

Diagram 26
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ProDriver4

Introducing ProDriver4, the leading edge in audio innovation for stage, studio and 
streaming from ICON Pro Audio. The Pro Driver audio system supplies you with the 
most reliable tools for almost any audio application - in the moment - right when you 
need them. The heart of the system is our driver, employing breakthrough technology 
and zero latency monitoring. The user interface makes it easy to grab, route and 
re-direct audio from any source in your computer with our virtual signal router. Use 
the Pro Driver Plugin Host to connect your favorite VST, Audio Units and Direct X 
plugins. Run ProDriver4 in standalone mode or with your favorite DAW. Save your 
favorite plugin chains as presets and recall them during your session or live on stage 
in real time.

r4

Dou22 

USolo

Diagram 28

Diagram 29
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Mixer control panel(Windows)
There are two different audio drivers including “WDM” (Windows Driver Model) and “ASIO” 
(Audio Stream Input and Output) within the ICON Pro Audio interface driver. WDM is widely 
used for daily software such as media player and ASIO is mainly used for most trecording 
software such as Logic Pro. The advantage of ASIO is that it has much lower latency than 
WDM and this is very important when you are recording with a heavy plugin load. Actually, 
most of the daily software does not support ASIO drivers and uses WDM only. In this  case 
you just simply need to use the HW channel (Hardware channels). Below please find some 
explanations on different terminology for each channel type.

1. HW IN (Hardware Channel IN) 
 � This means the hardware input channels including the microphones or internal input 

channels

2. HW Out (Hardware Channel OUT) 
 � This means the hardware output channels including the headphone or line out 

output channels 

3. VC Out (Virtual Channel OUT)
 � This only exists on ASIO driver and it is a virtual channel that’s output signal goes to 

ASIO VC IN

4. VC In (Virtual Channel IN)
 �  This only exists on ASIO driver and it is a virtual channel that‘s input signal is 

coming from ASIO VC Out

5. LoopBack (LoopBack Channel)
 � ASIO internal loopback channel (e.g. ASIO VC Out signal goes to ASIO VC IN)

1. USolo Hardware channels (HW In 1/2 & HW Out 1/2)
 � These are the hardware input and output channels on the USolo .

2. USolo Virtual channels (VC In 1/2, 3/4 and 5/6), (VC Out 1/2, 3/4 
and 5/6)

 � These are the input and output virtual channels that relate to the WDM. 
 � For example: WDM Out 1/2 linked to VC In1/2
 �    VC Out1/2 linked to WDM In1/2

3. USolo Loopback channels (LB 1/2, 3/4 and 5/6)
 � These are the ASIO loop-back channels.

On the mixer control panel, there are four different types of ASIO channels that you can 
manipulate.
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USolo

 � By activating different cross points, you may route the corresponding signal to your 
desired channels.

1. HW Input 1/2 level metering
 � Showing the hardware 1/2 input level (HW In 1/2).

2. HW Output 1/2 level metering
 � Showing the hardware 1/2 output level (HW Out 1/2).

3. VC In 1/2 (Virtual) input level metering
 � Showing the WDM 1/2 output level (VC In 1/2).

4. VC In 3/4 (Virtual) input level metering
 � Showing the WDM 3/4 output level (VC In 3/4).

5. VC Out 1/2 (Virtual) output level metering
 � Showing the ASIO 1/2 VC output level (VC Out 1/2).

6. VC Out 3/4 (Virtual) output level metering
 � Showing the ASIO 3/4 VC output level (VC Out 3/4).

7. VSC In 1/2 (Virtual) input level metering
 � Showing the WDM 1/2 output level (VSC In 1/2).

Diagram 30



23

8. VSC Music In 1/2 (Virtual) input level metering
 � Showing the WDM 1/2 output level (VSC music In 1/2).

9. VSC Out 1/2 (Virtual) output level metering
 � Showing the ASIO 1/2 VC output level (VSC Out 1/2).

10. VSC Music Out 1/2 (Virtual) output level metering
 � Showing the ASIO 1/2 VC output level (VSC music Out 1/2).

11. Loopback 1/2 
 � Showing the ASIO loop-back 1/2 channel’s level metering.

12. Loopback 3/4 
 � Showing the ASIO loop-back 3/4 channel’s level metering.

13. Loopback 5/6 
 � Showing the ASIO loop-back 5/6 channel’s level metering.

14. Link switch
 � Switch to adjust both channels level simultaneously.

15. Mute switch
 � Switch to mute the corresponding channel.

16. “0dB” switch
 � Switch to instantly adjust the corresponding channel to “0dB” level.

17. Gain control fader
 � Slide to adjust the gain level for the corresponding channel.

18. Inputs & Outputs Matrix switches
 � Switch to turn On/Off the corresponding input channel route to the corresponding  

output channel. The matrix is very useful and makes your inputs and outputs very 
flexible. You may route any of your input(s) to any output(s).

19. Mixer Presets
 � 6 Mixer-Presets button slots are available for saving or loading your routing 

channel settings.
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 � Click the “Setting” button to launch the settings window.

Sample rate setting
 � Select your desired sampling rate from 44.1KHz to 192KHz on the pull down 

window shown in Diagram 32. 

Settings (Sample rate and latency settings)

Diagram 31

Diagram 32
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Latency settings

 �
 ● Safe (maximum latency)
 ● Extra Large
 ● Normal
 ● Small
 ● Very Small 
 ● Minimum (minimum latency)
 ● Custom

 � There are six standard latency settings to select. If you would like to customize 
your own latency value, select custom. 

Diagram 33
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 � There are three different settings you can adjust to customize your own latency 
settings: These values include:

1. ASIO buffer Size
 � You may adjust the value ranging from 32/64/128/256/512/1024/2048 and 4096.

2. Streaming buffer Size
 � Adjustable settings: Minimum/Low/Normal/High and Maximum.

Diagram 34

Diagram 35
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3. Streaming buffer volume
 � Adjustable values: 2/3 and 4.

 � (Note: If a warning message appears on the “Latency Status” windows, please 
select a larger latency setting.)

 � (Note: If a clicking sound occurs, you should change to a larger buffer size 
for the settings. If the largest buffer size has been selected and there is still a 
clicking sound. It means your computer performance is not able to handle the 
task. (It is not caused by USolo digital audio interface.)

Diagram 36

Diagram 37
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ProDriver hosting rack (Mac/Windows)

With the ProDriver Rack, you can use any of your plug-ins with your DAW. Or you 
may use your device as standalone plug in effects without the need to run a DAW.

Click the "Rack" button on your ProDriver's mixer panel to launch the Virtual Rack 
window

USolo

Diagram 38
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Session & Preset
 � A session could contain unlimited presets. Each preset allows you to insert 

different plug-ins to create your desire sound effect or application need.

1、Create a New Session
 � Click "New Session" under the "file" tab on the top menu bar. Then click "Save 

Session" and input file name. 

2、Open a saved Session
 � Click "Open Session" under the "File" tab on the top menu bar and select the 

saved session file to open the session.

3、Save a Session
 � When you make any changes to your session, you may save it by clicking the 

"Save Session" function under the "File" tab on the top menu bar. If you would 
like to save as a new session, click "Save Session As" and input a new session 
name.

2
3

1

Create a New Preset
 � Click "New Preset" function under the "Edit" tab on the top menu bar. A new 

preset slot will create. 

Diagram 39

Diagram 40

 � Tip: To rename the preset, click the "Aa" button on the selected preset slot. 
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Delete a Preset
 � You may delete any preset. Select a preset and click "Delete selected preset" 

under the "Edit" tab on the top menu bar. 
 � Tip: You may also delete a selected preset by clicking the "Trash" button on the 

selected preset slot.
 �

Diagram 41

Diagram 42

Duplicate Current Preset
 � On occasion, you may like to make small changes to a current preset and 

compare the two. The function of "Duplicate Current Preset" will allow you to 
copy the current preset instantly. Then, you may make changes as you wish with 
one of the preset and make a comparison between the two. Click "Duplicate 
Current Preset" function on the "Edit" tab on the top menu bar.

 � Tip: You may duplicate a selected preset by clicking the third button on the right 
on the selected preset slot.  

 �
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Grouping a Preset
 � There are four "Preset Categories" including "Vocal", "Special", "MC" and 

"Others" that allow you group all your current presets. This is very useful to 
manage your different presets according to different application such as singing 
(Vocal), broadcasting (MC) or Guitar (Special) etc. To set a selected preset to a 
particular category - Click the "#" button in the selected preset slot and click the 
category from the pull down menu.

 �

Diagram 43
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1
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USolo

USolo USolo

USolo

Edit plug-ins in a preset
 � Click the "Pencil & Paper" button on the selected preset slot will launch the plug-

in rack screen where you would see 6 different routing blocks.
 �
 � 1. ProDriver Input routing block with orange connections
 � Depending on the number of I/O that your audio interface is equipped with, you 

will see a number of connections in orange. They are representative of the input 
channels of the audio interface.

 �
 � 2. ProDriver Output routing block with orange connections
 � Depending on the number of I/O that your audio interface is equipped with, 

you will see a number of connections in orange. They are representative of the 
output channels of the audio interface. 

 �
 � 3. ProDriver MIDI Input routing block with green connection
 � Depending on if your audio interface is equipped with MIDI I/O, you will see a 

connection in green. This is representative of the MIDI input channel of the audio 
interface.

 �
 � 4. ProDriver MIDI Output routing block with green connection
 � Depending on if your audio interface is equipped with MIDI I/O, you will see a 

connection in green. This is representative of the MIDI output channel of the 
audio interface.

 �

Diagram 44
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 � 6. Voice Over routing block
 � This is a routing block intended for the use of Voice Over function. Right clicking 

the block will launch the plug-in pull-down menu for all the available plug-ins. 
Click the desired plug-in to select. We have created a small ‘activate’ shortcut 
button on the ProDriver floating icon. Simply click the "V" button to activate or 
deactivate the function.

 �
 � Tip: As well as using this facility as a Voiceover function, you may consider 

using this for other functions – please insert a corresponding plugin 
 �

 � 5. Mute routing block
 � This is a routing block intended for use with the Mute function. Right clicking 

the block will launch the plug-in pull-down menu for all the available plug-ins 
- click the desired plug-in to select. To use the block as a "Mute" function, we 
have created a small ‘activate’ shortcut button on the ProDriver floating icon. 
Simply click the "M" button – this will activate or deactivate the function.

 �
 � Tip: As well as using this facility as a Mute function, you may consider using 

this for other functions – please insert a corresponding plugin.
 �

Diagram 45
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Import all your available plug-ins
 � To import all your available plug-ins, click "View" tab on the top menu bar and 

click "Plugin Manager" to launch the Plugin Manager window. Click "Scan VST" 
or "Scan VST3" to scan your computer all the available corresponding plugins 
automatically. A list of all available plugins will be shown after they have been 
imported automatically and ready to be used in ProDriver.

 �

Diagram 46
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USolo

USolo

USolo

USolo

Add plug-in and make routing
 � It is extremely easy to add plug-ins and create routing between input channels 

and output channels. Simply pull & drag the connection cable from connection 
point to point. To add a plug-in, right click your mouse, you will see all the 
available plug-ins that you have in your computer in the pull-down menu, then 
just click the plug-in to select. 

 �

1

2 3

4

Buttons
 � 1、Click to launch the plug-in control panel (GUI) to adjust settings. 
 � 2、Click to delete all the virtual connections that are connected to the block.
 � 3、Click to delete the routing /plugin block
 � 4、Click to activate or deactivate the routing/plugin block

Diagram 48

Diagram 47
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Hardware Connections
Connect the USolo digital audio interface outputs to your amplifier or powered 
monitors. Ensure the Master volume is set to a suitable volume setting.

If you are monitoring through headphones, connect your headphones to the device's 
headphone output. Ensure the headphone volume is set at a low volume, to ensure 
ear safety.

Connect your microphone/guitar to the device's analog input. 

Please refer to the diagrams on the following pages.

MacMac / PC

or

Android

Power Pack

1

2

or

6.35

PC/MAC Only

Smart Device Only
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Different types of microphone connection 
method diagram

Note: For dynamic microphone user, please make sure +48V phantom power switch
is “OFF” before you plug in your microphone, otherwise it may cause damage to your
microphone.

1/4” TR
Unbalanced

Dynamic
Microphone

(D2)

Condenser
Microphone

(Apollo)

XLR
Balanced

Or
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Specifications
ADC: 
   Dynamic Range:  ......................................... 98dB, A-weighted
   Signal-to-Noise Ratio: ................................. -98dB, A-weighted
   THD+N Ratio:  ............................................. -90dB, -1dBFS

DAC:
   Dynamic Range: ..........................................  108dB, A-weighted
   Signal-to-Noise Ratio:..................................  -108dB, A-weighted
   THD+N Ratio: ..............................................  -91dB, 0dBFS

Mic Input(XLR, Balanced):
   Frequency Response:  ................................ 20Hz to 20kHz (+/-0.1dB)
   Noise EIN:  .................................................. <-120dB
   Input Impedance: .........................................  1.8K Ohms
   Gain Range: ................................................  0dB~+52dB
   Maximum Input Level: .................................  +9dBu

Instrument Input(6.35mmTRS, Unbalanced):
   Frequency Response:  ................................ 20Hz to 20kHz (+/-0.1dB)
   Input Impedance:  ........................................ 390K Ohms, typical
   Gain Range:  ............................................... +6dB~+45dB
   Maximum Input Level: ................................. +9dBu 

Line Outputs 1/2 (Stereo, Unbanced):
   Frequency Response: ................................. 20Hz to 20kHz (+/-0.1dB)
   Nominal Output Level: ................................. +6dBu, typical
   Maximum Output Level:............................... +10dBu
   Output Impedance: ...................................... 150 Ohms
   Load Impedance: ......................................... 600 Ohm minimum

Headphone Outputs: (Stereo, Unbanced)
   Frequency Response: ................................. 20Hz to 20kHz (+/-1dB)
   Maximum Output Level:............................... +9dBu, typical
   Output Impedance: ...................................... 10 Ohms
   Load Impedance: ......................................... 32 to 600 Ohms

Dimensions and Weights
   Dimension.................................................... 145mmX130mmX39mm
........................................................................ (5.7" X 5.1" X 1.5")
   Weight ......................................................... 0.234kg
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Services
If your USolo needs servicing, follow these instructions.

Check our online Help Center at ttp://support.iconproaudio.com, for information, 
knowledge, and downloads such as:
1. FAQ
2. Download
3. Learn More
4. Forum
Very often you will find solutions on these pages. If you don’t find a solution, create 
a support ticket at our online Help Center at the link below, and our technical support 
team will assist you as soon as we can.
Navigate to ttp://support.iconproaudio.com and then sign in to submit a ticket. 
As soon as you have submitted an inquiry ticket, our support team will assist you to 
resolve the problem with your ICON ProAudio device as soon as possible.

To send defective products for service:

1. Ensure the problem is not related to operation error or external system devices.

2. Keep this owner's manual. We don't need it to repair the unit.

3. Pack the unit in its original packaging including end card and box. This is very 
important. If you have lost the packaging, please make sure you have packed 
the unit properly. ICON is not responsible for any damage that occurs due to 
non-factory packing.

4. Ship to the ICON tech support center or the local return authorization. See our 
service centers and distributor service points at the link below:

 �
 � If you are located in US
 �  Send the product to:
 � North America
 � Mixware, LLC – U.S. Distributor
 � 3086 W. POST RD.
 � LAS VEGAS NV 89118
 � Tel.: (818) 578 4030
 � Contact: www.mixware.net/help
 �
 �  If you are located in Europe
 �  Send the product to:
 �  Sound Service 
 � GmbHEuropean 
 � HeadquarterMoriz-Seeler-Straße 
 � 3D-12489 Berlin 
 � Telephone: +49 (0)30 707 130-0
 �  Fax:  +49 (0)30 707 130-189
 �  E-Mail: info@sound-service.eu 

 � If you are located in Hong Kong
 � Send the product to:
 � ASIA OFFICE: 
 � Unit F, 15/F., Fu Cheung Centre, 
 � No. 5-7 Wong Chuk Yueng Street, 

Fotan, 
 � Sha Tin, N.T., Hong Kong.
 � Tel: (852) 2398 2286
 � Fax: (852) 2789 3947
 � Email: info.asia@icon-global.com
 �

5. For additional update information please visit our website at:
 � www.iconproaudio.com
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www.twitter.com/iconproaudio www.youtube.com/iconproaudiowww.instagram.com/iconproaudio www.facebook.com/iconproaudio

Twitter Instagram Facebook Youtube

Website

iconproaudio.com/dashboard/

DashboardSupport

support.iconproaudio.comwww.iconproaudio.com

中国地区用户

微信号iCON-PRO

微信公众号

4006311312.114.qq.com

官方售后QQ

抖音iCON艾肯

抖音号

B站iCONProAudio

哔哩哔哩

天猫店iconproaudio旗舰店

天猫官方旗舰店
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